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LICENSE TERMS AND CONDITIONS

FasTrak SoftWorks, Inc.

Licensor is the owner of all rights, including the copyright, in and to that certain set of executable computer programs identified

in the Registration Form, including design and structure thereof (the "Software"), together with all manuals and other written or

printed technical material provided with the Software to explain its operation and to aid in its use (the "Documentation").

Licensee wishes to have the right to use the Software, and Licensor is willing to grant such a right to Licensee on the terms and

conditions set forth herein.

1. GRANT OF LICENSE. In consideration of Licensee's payment of the license fee referred to below and Licensee's agreement

to abide by the terms and conditions stated herein, FasTrak SoftWorks, Inc. (referred to as "Licensor") grants Licensee a

nonexclusive right to use and display one (1) copy of the Software with respect to one microcomputer at a time for so long as

Licensee complies with the terms hereof. Licensor retains the right to terminate this Agreement and Licensee's rights at any time,

by written notice to Licensee, in the event Licensee violates any of the provisions hereof.

Licensor reserves all rights in and to the Software and Documentation not expressly granted to Licensee herein. Licensee agrees

to pay Licensor the license fee specified by Licensor as of the date hereof, payable in full upon deliver of a copy of the

Software and Documentation to Licensee. Licensee acknowledges that the license fee payable hereunder is consideration solely

for the right to use the Software, and payment thereof will not entitle Licensee to support, assistance, training, maintenance or

other services, or the enhancements or modifications to the Software which may subsequently be developed by Licensor, except

as otherwise expressly provided in this Agreement.

2. LICENSEE'S AGREEMENTS. Licensee agrees to comply with the terms and conditions set forth in this Agreement,

specifically including but not limited to the following:

a. Licensee will take all reasonable steps to protect the Software from theft or use contrary to the terms of this

Agreement.

b. Licensee agrees to pay Licensor additional license fees as specified by Licensor if and to the extent Licensee intends

to use or does use the Software in any way beyond the scope of this Agreement.

c. Licensee agrees not to modify the Software and not to disassemble, decompile, or otherwise reverse engineer of the

Software.

d. Licensee agrees to either destroy or return the original and all existing copies of the Software to Licensor within

five (5) days after receiving notice of Licensor's termination of this Agreement.

e. Licensee agrees not to disclose the Software or Documentation or any part thereof or any information relating

thereto to any other party, it being understood that the same contains and/or represents confidential information

which is proprietary to Licensor.

3. OWNERSHIP OF SOFTWARE. Licensee shall be deemed to own only the magnetic or other physical media on which the

copy of the Software provided to Licensee is originally or subsequently recorded or fixed, as well as any boards, key-locks, or

cables provided for use with the Software, but an express condition of this Agreement is that Licensor shall at all times retain

ownership of the Software recorded on the original diskette copy and all subsequent copies of the Software, regardless of the

form or media in or on which the original or other copies may initially or subsequently exist. This Agreement does not

constitute a sale of any copy of the Software to Licensee.

4. POSSESSION AND COPYING. Licensee agrees that the Software will only be displayed or read into or used on one (1)

computer at a time, at the location designated for notices to Licensee under paragraph 13, below. Licensee may change the

computer on which Licensee uses the Software to another computer at such location. Licensee agrees not to make copies of the

Software other than for its own use, all of which copies shall be kept in the possession or direct control of Licensee. Licensee

agrees to place a label on the outside of all copies showing the program name, version number, if applicable, and Licensor's

copyright and trademark notices in the same form as they appear on the original licensed copy

5. TRANSFER OR REPRODUCTION. Licensee is not licensed to copy, rent, lease, transfer, network, reproduce, display or

otherwise distribute the Software except as specifically provided in this Agreement. Licensee understands that unauthorized

reproduction of copies of the Software and/or unauthorized transfer of any copy of the Software is a violation of law and will

subject Licensee to suit for damages, injunctive relief and attorney's fees. Licensee further understands that it is responsible for

the acts of its agents and employees. Licensee may not transfer any copy of the Software to another person or entity, on either a

permanent or temporary basis, unless Licensee obtains the prior written approval of Licensor which will ordinarily be subject to

payment of Licensor's then current license transfer fee. Such approval will not unreasonably be withheld if Licensee advises

Licensor in writing of the name and address of the proposed transferee, such transferee is suitable in Licensor's sole judgement,

and such transferee agrees in writing to be bound by the terms and conditions of this Agreement. If the transfer is approved,

Licensee must deliver all copies of the Software, including the original copy to the transferee.



6. ENHANCEMENTS AND UPDATES. Licensor may from time to time release updates of the Software incorporating changes

intended to improve the operation and/or reliability of the Software. Such updates will be provided to Licensee at no charge

(except shipping charges and media costs) for a period of twelve (12) months from the date hereof, and Licensee agrees to install

all updates designated by Licensor as mandatory. Licensor may also offer enhanced versions of the Software from time to time

incorporating changes intended to provide new or enhanced features and/or capabilities, at such license fees as Licensor may

from time to time establish.

7. LIMITED WARRANTY AND DISCLAIMER OF LIABILITY. LICENSOR HAS NO CONTROL OVER THE

CONDITIONS UNDER WHICH LICENSEE USES THE SOFTWARE. THEREFORE, LICENSOR CANNOT AND DOES

NOT WARRANT THE PERFORMANCE OR RESULTS THAT MAY BE OBTAINED BY ITS USE. HOWEVER,

LICENSOR PROVIDES THE FOLLOWING LIMITED WARRANTY:

Licensor warrants, for a period of twelve (12) months only, that the Software shall be free from significant programming errors.

Licensor further warrants that it has full power and authority to grant the rights granted by this Agreement with respect to the

Software and that the use by Licensee of the Software and Documentation will not infringe the rights of others. In the event

Licensee believes that it has discovered one or more significant programming errors, Licensee shall immediately notify Licensor

of such fact in writing. If such notice is received by Licensor within twelve (12) months from the date hereof, Licensor shall,

within a reasonable time, subject to the demands of Licensor's other customers and subject to delays beyond Licensor's control

(including but not limited to labor trouble, illness, delays in shipment of materials, and bad weather), at Licensor's expense,

correct the programming errors. In the event Licensor is unable to correct the programming error within a reasonable time,

Licensee may elect to terminate this Agreement and receive a refund of the licensee fee paid hereunder. For purposes hereof, a

programming error is "significant" only if, as a result thereof, the software does not substantially perform the functions

described in the Documentation. Licensor does not warrant that the operation of the Software will be uninterrupted or error

free. EXCEPT FOR THE ABOVE EXPRESS WARRANTY, LICENSOR MAKES AND LICENSEE RECEIVES NO

WARRANTIES, EXPRESS, IMPLIED, STATUTORY OR OTHERWISE, AND LICENSOR SPECIFICALLY DISCLAIMS ANY

IMPLIED WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

THE REMEDY PROVIDED HEREIN IS EXCLUSIVE. UNDER NO CIRCUMSTANCES WILL LICENSOR BE

RESPONSIBLE FOR DIRECT, INDIRECT, INCIDENTAL, CONSEQUENTIAL OR OTHER DAMAGES OR LOST

PROFITS. LICENSEE ACKNOWLEDGES THAT THE LICENSE FEE HEREUNDER IS NOT ADEQUATE FOR

LICENSOR TO ASSUME OBLIGATIONS TO LICENSEE GREATER THAN THE EXPRESS REMEDY PROVIDED

ABOVE.

8. GOVERNING LAW. The validity and performance of this Agreement shall be governed by Wisconsin law, except as to

copyright and trademark matters which are governed by United States laws and international treaties. This Agreement is deemed

entered into in Wisconsin. All lawsuits arising out of this Agreement shall be brought in a court of general jurisdiction in

Milwaukee, Wisconsin. Licensor shall be entitled to recover its costs and expenses (including attorney's fees) incurred in

enforcing its rights under this Agreement.

9. WAIVER. The failure of Licensor to enforce any of the provisions hereof shall not be construed to be a waiver of the right to

enforce such provisions at a later time or to enforce any of the other provisions hereof.

10. EFFECT OF TERMINATION. The expiration or termination of this Agreement shall not affect the obligations of Licensee

which by their character are of continuing nature.

11. INTEGRATION. This Agreement sets forth the entire understanding and agreement of the parties shall be bound by any

conditions, definitions, warranties or representations with respect to any of the terms or conditions hereof other than as

expressly provided in this Agreement. This Agreement may only be modified by a writing signed by the party to be charged.

12. BINDING EFFECT. This Agreement shall be binding upon and shall inure to the benefit of the parties hereto and their

respective successors and assigns, subject to the limitations on the transfer of Licensee's rights to the Software provided in

paragraph 5, above.

13. NOTICES. All notices shall be in writing and shall be hand delivered or sent by U.S. mail, first class, postage prepaid, if to

Licensor at its address first above written, and to Licensee at the address indicated in the Registration Form. A party may change

its address for notices at any time by notice to the other party in the manner provided herein, but each party may have only one

address for notices at a time.

14. REGISTRATION FORM. The Registration Form is a part of this Agreement and is incorporated herein by reference. This

Agreement will not take effect, and Licensee will have no rights whatsoever with respect of the Software, unless and until the

Registration Form is duly executed and returned to the Licensor and is accepted by Licensor.
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FTVersionTrak Client Requirements

The following is required to install the FTVersionTrak client:

l Operating systems supported:

l Windows XP Professional Sp1A or later

l Windows Vista (Business or Enterprise)

l Windows 7 (Professional, Enterprise, or Ultimate)

l Windows 8 and Windows 8.1

l Windows 10

l 100 MB free disk space

l FTVersionTrak requires Microsoft Data Access Components (MDAC) v2.7.
MDAC 2.7 will be installed or updated automatically to meet this requirement.

l FTVersionTrak requires the .NET framework 2.0 or higher; this component will
be installed or updated automatically to meet this requirement.

NOTE: You must be logged in as the administrator to install FTVer-

sionTrak. In addition, Windows User Access Control must

be disabled to install and use FTVersionTrak.
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MS SQL Server Express Database

Requirements

The following is required to install the SQL Server Express database:

l Operating systems supported:

l Windows 10

l Windows 8

l Windows 7

l Windows Server 2008

l Windows Server 2008 R2

l Windows Server 2003 Service Pack 2

l Windows Vista Service Pack 1

l Windows XP Service Pack 3

l 32-bit systems

l Intel orcompatible 1 GHz orfasterprocessor (2 GHz orfaster recommen-
ded)

l Minimum of 256 MB of RAM ( 1 GB or more is recommended)

l 1 GB of free hard disk space

l 64-bit systems

l 1.4 GHz or higher processor (2 GHz or faster recommended).

l Minimum of 256MB of RAM (1 GB or more is recommended)

l 1 GB of free hard disk space
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Disabling User Access Control (UAC)

Windows User Access Control (UAC) must be disabled in order to install and use FTVer-

sionTrak. Log in as a Windows Administrator and follow the instructions below to disable

UAC for Windows Vista, 7, 8, 10, and 11. Windows XP does not use UAC.

Windows 10 and 11

1. From Control Panel, select User Accounts > User Accounts > Change User
Account Control Settings.

2. Move the slider to the Never notify position.

3. Restart the computer, so changes take effect.

Windows 7 and 8

1. Open User Account Control Settings by clicking the Start button, and then clicking
Control Panel. In the search box, type uac, and then click Change User Account
Control settings.

2. To turn off UAC, move the slider to the Never notify position, and then click OK.
If you're prompted for an administrator password or confirmation, type the pass-
word or provide confirmation. You will need to restart your computer for UAC to
be turned off.

Windows Vista

1. Open User Accounts by clicking the Start button, clicking Control Panel, clicking
User Accounts and Family Safety (or clicking User Accounts, if you are con-
nected to a network domain), and then clicking User Accounts.

2. Click Turn User Account Control on or off. If you are prompted for an ad-
ministrator password or confirmation, type the password or provide confirmation.
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3. Clear the Use User Account Control (UAC) to help protect your computer
check box to turn off UAC and then click OK. You may need to restart your com-
puter for UAC to be turned off.
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Installation Instructions

1. Insert the FTVersionTrak CD into your computer’s CD-ROM drive.

2. The Install Wizard should start automatically. If not, open the file explorer, select
the CD-ROM drive in the left pane, and run the setup.exe file.

3. The FTVersionTrak Install Shield Wizard appears. This utility determines if any ne-
cessary software components must be installed to support FTVersionTrak. Below is
an example of items that the Wizard may install. Click Install.

4. Click Install to begin Installation.

NOTE: You must be an Administrator to install FTVersionTrak.
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5. The Microsoft .NET Framework installation beings.

6. Accept the Microsoft .NET Framework terms and conditions, then click Install to
begin the installation.
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7. When installation is complete, click Finish to continue.

- 13 -



FTVersionTrak Quick Start Guide

8. The following screen gives you the option to install Microsoft SQL Server. Click
Yes to install SQL, or click No to skip this step.

9. After installation of SQL is complete, the following screen gives you the option to
install Sentinel Protection Driver (FT-KEY Driver). Click Yes to install the Sentinel
Protection Driver, or click No to skip this step. This step is required for use of
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FTVersionTrak with keyed licenses.

10. After installation of Sentinel Protection Driver is complete, the FTVersionTrak cli-
ent Install Shield Wizard appears. Click Next.

- 15 -



FTVersionTrak Quick Start Guide

11. Accept the FasTrak license terms and conditions, then click Next to continue.

12. Enter a user name (required) and organization name (optional). Click Next to con-
tinue.

- 16 -



FTVersionTrak Quick Start Guide

13. On the Setup Type window, select Complete. Click Next.

14. Select who should have access to the FTVersionTrak application. Click Install.
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15. After installation of the FTVersionTrak client is complete, click Finish to complete
installation.
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Demo Mode Restrictions

If using this software without a license, you may run FTVersionTrak in demo mode, which

restricts the application to limited functionality. Running FTVersionTrak in demo mode

gives you the opportunity to try out all of FTVersionTrak's powerful features before buy-

ing a license for it.

When you start FTVersionTrak without a license the following message appears:

Click Demo to run FTVersionTrak in demo mode.

The following restrictions apply when using FTVersionTrak in demo mode:

Users will be able to:

l Create one repository.

l Add any of the 10 included example files in the repository.

l Create up to four versions of any one file.

l Compare versions of any of the included example files.

Once you have reached your file and version limit, if you would like to continue evaluating

the demo, you can reset the repository and start again by clicking Restore Respoitory to

Factory State on the File menu. This function will clear all data from the repository and

reset any configured settings to their defaults. Please note that you cannot add any files to

the repository other than the sample files provided with the demo, and that these files can-

not be altered in any way prior to adding to the repository. Attempts to add modified

sample files or any other files to the repository while in demo mode are restricted and will

result in an error.

If you do not have a license and would like to receive the full functionality of FTVer-

sionTrak, contact the FasTrak sales department at sales@fast-soft.com or call

262.238.8088.
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Setting Local Security Policy

By default, many Windows installations force network logins that use local accounts to be

authenticated as Guests. FTVersionTrak requires that network logins that use local ac-

counts must authenticate themselves. To accomplish this, the server machine's Local

Security Policy must be changed to permit local users to authenticate as themselves. Ask

your IT or network administrator for assistance, or consult your Windows documentation

for the specific procedures to follow for your version of Windows. The following in-

structions describe how to change the local security using Windows XP Professional (other

versions of Windows may require different instructions):

1. Click Control Panel on the Start menu.

2. In Control Panel, double-click the Administrator tools icon.

3. In the Administrative tools window, double-click Local Security Policy.

4. Under Security Settings, open the Local Policies folder.

5. In the Local Policies folder, open the Security Options folder.

6. In the Policy column, double-click Network access: sharing and security
model for local accounts.

7. In the Network access: sharing and security model for local accounts dialog box,
change the setting from Guest only - local users authenticate as Guest to Clas-
sic - local users authenticate as themselves and click OK.

8. Restart the computer.
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Checking Firewall Settings

Dependingonthe type of firewall usedat yourorganization, you may need toaddFTVer-

sionTrak andSQLServeras exceptions inorder togrant remote users access to

FTVersionTrak. Consult the documentation that came withyourfirewall, or talk toyourIT or

network administrator, forassistance inconfiguringyourfirewall foruse withFTVersionTrak.
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Checking Anti-Virus Settings

Antivirus programs such as Symantec's Norton AntiVirus and McAfee VirusScan also

block programs from permitting incoming communications requests. SQL Server must be

permitted to accept incoming requests to allow remote FTVersionTrak users to access a re-

pository. See your system administrator or consult your antivirus software manual for

information about program access permissions.
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Server Security 

Server Security regulates and maintains user access to FTVersionTrak databases. Ad-

ministrators define the SQL Server instance to be used as an FTVersionTrak database,

select the users that will have access to the database, and determine the method of access

allowed to each user of the database.

To access Server Security:

1. On the Tools menu, click Server Security or click the toolbar button. The
Master Login dialog box appears.

2. Click OK. By default, Windows Authentication is selected – this is the only au-
thentication method that can be used to access Server Security.

NOTE: Only administrators may access Server Security. Continue

reading for more information about adding and managing

users.

After successfully logging in, the Server Security dialog box appears.
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3. The Server Security dialog box displays the following information:

n Server: Displays the server being configured.

n Accounts: Displays all configured server accounts.
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Selecting a Server

1. In the Server Security dialog box, the SQL Server instance you will be configuring is
displayed in the Server box. In cases in which multiple servers reside on the same
machine, clicking Browse will display a list of available servers. Select the server
you would like to configure or click Find Database Servers to search for all ac-
cessible servers.

2. Click OK when finished to return to the Server Security dialog box.

NOTE: Clicking Find Database Servers searches for all available

servers, including servers located on remote machines. You

must be logged in to Windows as an administrator on the ma-

chine on which SQL Server is running to access Server

Security.

Viewing Server Accounts

A list of all available SQL Server accounts is displayed in the Server Security dialog box.
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Server Security supports two different types of accounts, displayed in the Account Type

column:

l Windows Login represents a single user with a Windows login on the same ma-
chine as SQL Server connecting via Windows Authentication.

l SQL Login represents a single user logged in from a local or remote location
to SQL Server via SQL Authentication.

NOTE: To allow workgroup users to log in to FTVersionTrak using

Windows Authentication, the server machine's Local Se-

curity Policy must be set to allow local users to authenticate

as themselves. See Editing Local Security Policy in the on-

line help for more information.

l Show disabled users by selecting the Show Disabled Server Accounts check
box. You may disable an account in the Edit Server User dialog box accessed by
clicking Edit .

Managing Server Accounts

Adding Users

To add SQL Server accounts that may access the FTVersionTrak database:

1. In the Server Security dialog box, click Add. The Add SQL Server Account dialog
box appears.
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2. In the Login Type box, select the type of login you would like to add (Windows or
SQL Authentication).

3. Configure the login you would like to add:

Windows Authentication

Type the name of the user in the Username text box or click Select to search for available

users. If you choose to search, the Select User dialog box appears.

l Type search criteria in the Enter the object name to select box, or click Ad-
vanced for more options.

l Click Find Now to search for all available logins from a single location.

l Select a login from the list and click OK.
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l Click OK when finished to return to the Add SQL Server Account dia-
log box.
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The Password and Confirm text boxes cannot be selected; this information is governed

by Windows Authentication.

NOTE: To allow workgroup users to log in to FTVersionTrak using

Windows Authentication, the server machine's Local Se-

curity Policy must be set to allow local users to authenticate

as themselves. See SQL Server Setup in the online help for

more information.

SQL Authentication

l Enter the username and password of the SQL Server account you would like
to configure in their respective fields. Retype the password in the Confirm
box.

NOTE: The SQL Server instance must be configured to accept

SQL Server Authentication. See SQL Server Setup in

the online help for more information.

4. Select the Login Disabled check box to block this account's access to the FTVer-
sionTrak database.

5. Click OK when finished to return to the Server Security dialog box.

Editing Users

To edit SQL Server accounts that may access the FTVersionTrak database:

1. Click Edit in the Server Security dialog box. The Edit SQL Server Account dialog
box appears.
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2. Select the Login Disabled check box to block this account's access to the FTVer-
sionTrak database.

3. Click OK when finished to return to the Server Security dialog box.
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Creating a Repository

Before you can begin adding files to FTVersionTrak, you must have a repository to manage

them in. If no repository has been created for your project, the first step is to create one.

NOTE: FTVersionTrak PE users may only create one repository per

license.

To create a repository:

1. Click CreateNewRepository ontheFilemenu orpressCTRL+N. The Create New
Repository dialog boxappears. (This dialogboxcanalsobe accessed fromthe Connect
toRepository dialogbox. See Connecting toaRepository formore information.)

2. The default server is listed in the Server box. To select another server, click
Browse. The Browse for Server dialog box appears.
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3. If the server you want to use is not displayed in the Server list, click Find Data-
base Servers to search for all available servers. Click the server you want and then
click OK to return to the Create New Repository dialog box.

NOTE: If the server you are looking for still does not appear on the

list, contact your system administrator or see SQL Server

Setup for setup information.

4. Type the name of the new repository in the Repository Name box.

NOTE: The repository name cannot contain spaces or special char-

acters.

5. Click OK when finished. The Master Login dialog box appears.

5. ClickOKtocreate the repository. By default, Windows Authentication is selected– this
is the only authenticationmethod that canbe usedwhencreatingnew repositories:

NOTE: Whichever user creates a repository automatically becomes

the administrator of that repository, granting the user all re-

pository privileges. See Repository Security for more

information.
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Connecting to a Repository

Multiple repositories can be created and accessed by users depending on project needs and

storage space. Each repository may have its own set of users, and each user may have its

own set of Repository Permissions within each repository. After the administrator creates a

repository, other users might need to connect to it.

To connect to an existing repository:

1. Click Connect to Repository on the File menu, click the toolbar button, or
press CTRL+C. The Connect to Repository dialog box appears.

2. If you have connected to any repositories previously, they appear in the Select a Re-
pository list. If no repositories have been previously connected to, or if the
repository you want to use is not listed, click Browse. The Browse for Repository
dialog box appears.
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3. The default server will be listed in the Server box. To select another server, click
Browse. The Browse for Server dialog box appears.

4. If the server you want to use does not appear in the Server list, click Find Data-
base Servers to search for all available servers. Select the server you want to use
from the list and then click OK to return to the Connect to Repository dialog box.

NOTE: If the server you are looking for still does not appear on the

list, contact your system administrator or see SQL Server

Setup for setup information.
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5. Select the Login to Server Manually check box to force a manual login to the
server. Use this option if a different user usually logs in automatically and the login
needs to be changed.

6. Click Find Repositories to search for available FTVersionTrak repositories located
on the server.

7. Select the repository you want to use from the Available Repositories list and then
click OK when finished to return to the Connect to Repository dialog box.

NOTE: If the repository you are looking for still does not appear on

the list, contact your system administrator or see the Ad-

ministrator Guide for setup information.
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n Click Remove to remove a repository from the Select a Repository list. Click-
ing Remove does not delete the repository – it only removes the repository
from the list.

n Click New to Create a New Repository.

8. Select the repository and click Connect. The Master Login dialog box appears.

9. Select the mode of authentication from the Authentication box:

n Windows Authentication: This option utilizes the local Microsoft Windows
user accounts to log on to the server. If this option is selected, the user currently
logged in to Windows will appear in the Username text box. No password is ne-
cessary, and the login information cannot be edited.

n SQL Authentication: This option uses the login information located on the
server itself. Selecting this option will prompt for both a username and password.
See your system administrator for more information.

10. Click OK to connect to the repository.
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Repository Security

Repository security defines access permissions for each repository being protected by

FTVersionTrak. The repository administrator (usually the creator of the repository) de-

termines the users that can access a repository, as well as the level of access each user or

group of users receives. Each repository may have a different administrator, who can either

set predefined access 'levels' for each repository user, or define custom levels of security

for one or many users based on specific repository permissions.

To access Repository Security:

1. On the Tools menu, click Repository Security or click the toolbar icon. The
Repository Security dialog box appears.

Managing Repository Users

AddingUsers

To add a new repository user:
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1. On the Tools menu, click Repository Security or click the toolbar icon. The
Repository Security dialog box appears.

2. Click Add User. The Add Repository Account dialog box appears.

3. Select the account you want to add and click OK. The Repository User dialog box
appears, which can be used to define the access permissions of the account.
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NOTE: All accounts must first be added as SQL Server accounts un-

der Server Securitybefore they can be selected as repository

accounts.

ManagingUser-Level Account Permissions

To define the access permissions of an individual account:

1. From the Repository Security dialog box, select the account to edit and click Edit.
The Repository User dialog box appears.

The Access Level tab contains pre-defined access levels that can be applied to a user

quickly and conveniently. The permissions associated with these pre-defined levels are Ad-

ministrator, Power Editor, Limited Editor, and Read-Only.
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A Custom access level also exists so that repository administrators may define specific re-

pository permissions for a user or group of users.

Account permissions can also be applied to a user by adding them to a repository group

that already contains a defined permission set. Adding a user to a repository group is a great

way to quickly define security levels to a large group of users with similar needs. FTVer-

sionTrak provides you with a set of default groups based on the pre-defined access levels

described earlier: Administrator, Power Editor, Limited Editor, and Read-Only.

NOTE: Repository accounts cannot be removed from within Re-

pository Security. Account removal may only be

accomplished within Server Security by an authorized server

administrator. To deny an account access to a specific re-

pository, disable the account.

Individual users may also be granted specific permissions via repository group membership;

users may also be members of more than one repository group at a time. The actual set of

permissions granted to any user in a repository is therefore the sum of all permissions gran-

ted either on an individual user basis, or via membership in any repository group. The full

details of a user's group membership and permission set can be viewed in the Member Of

tab of the Repository User dialog box.

ManagingRepositoryGroups

FTVersionTrak allows administrators to grant over 80 selectable permissions in 13 dif-

ferent areas of the software to each user in a repository. This powerful set of options gives

administrators the ability to fine-tune the security policy they apply to the repositories they

manage in order to maintain the strictest control over the sensitive files they manage,

without hindering the productivity of the users who need access to those files. However,

because of the sheer number of security options available, configuring each repository user

with a unique permission set can be cumbersome, especially if the administrator is dealing

with many, or perhaps hundreds, of users.

FTVersionTrak repository groups provide repository administrators with a simple, yet

powerful, way to manage the security policy for a large set of users with varying access

levels. With just a small amount of planning, administrators can create permissions-based

groups that can meet the needs of every type of user in the organization.

TOCREATE A REPOSITORY GROUP:

1. On the Tools menu, click Repository Security or click the toolbar button.
The Repository Security dialog box appears.
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2. Click the Groups tab in the Repository Security dialog box. A list of existing re-
pository groups appears. Four pre-defined groups are provided by default:
Administrator, Power Editor, Limited Editor, and Read Only.

3. Click New Group. The Repository Group dialog box appears.
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4. Enter a name for the group in the Group Name box. Depending on your security
needs, you may want to create groups based on business unit (Maintenance, Engin-
eering, Marketing, and so on) or employee type (Contractors, Management, and so
on).

5. If you have repository users that you know will be added to the group at this time,
you may select the users from the Available Users list at the bottom of the Re-
pository Group dialog box (you can add additional users to the group at any time).
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NOTE: Notice that there is already a user assigned to the group –

this is the account of the repository creator, who is also the

default administrator of the repository. The repository cre-

ator always has full permissions granted within the

repository, and is always a member of every repository

group. The repository owner is also by default the owner of

the repository group.

6. Click the Access Level tab at the top of the Repository Group dialog box to define
repository permissions for group members.

The Access Level tab contains pre-defined access levels that can be applied to a repository

group quickly and conveniently. The permissions associated with these pre-defined levels
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are Administrator, Power Editor, Limited Editor, and Read-Only. See Repository Ac-

count Permissions for more information about the permissions assigned to each access

level.

A Custom access level also exists so that repository administrators may define specific re-

pository permissions for the repository group.

NOTE: Individual users may also be granted specific permissions

outside of group membership; users may also be members of

more than one group at a time. The actual set of permissions

granted to any user in a repository is therefore the sum of all

permissions granted either on an individual user basis, or via

membership in any repository group. The full details of a

user's group membership and permission set can be viewed

in the Member Of tab of the Repository User dialog box.

Repository Access Privileges

A repository account permission is a right to carry out an operation on or applied to a re-

source within FTVersionTrak. These rights can be granted or revoked by a repository

administrator. See the online help for more information about repository account per-

missions.

FTVersionTrak provides four default access levels with varying degrees of granted per-

missions: Administrator, Power Editor, Limited Editor, and Read-Only. These four

access levels serve two purposes. First, they provide a quick and simple way to assign a pre-

defined permission set to a user or group of users without having to grant each permission

manually. Second, these default access levels provide administrators of earlier versions of

FTVersionTrak a transition path to the new group-based security structure without re-

quiring a complete redesign of the existing FTVersionTrak security policy. These four

default access levels are carry-overs from previous versions of FTVersionTrak and will re-

tain existing permissions from earlier versions of the software.

NOTE: Certain repository accounts, such as the account associated

with the creator of the repository, will automatically be set

to the Administrator access level and be granted all per-

missions. This account cannot be edited or deleted, to

prevent against accidental removal of all accounts with ad-

ministrative access.
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Adding Files and Folders to the

Repository

Create folders in your repository to customize the repository’s file structure and keep your

repository files organized and easy to access.

To create a new repository folder:

1. Do one of the following:

l On the File menu, click Create New Folder.

l Right-click an existing folder and then select New folder from the short-
cut menu.

l Click the Create New Folder toolbar button.
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2. The default name of the created folder is New Folder. Type the new name of the
folder within the highlighted text box and press ENTER when finished.

The left pane of the FTVersionTrak main window contains the folder tree. Similar in ap-

pearance to Windows Explorer, the folder tree is a listing of the folders in the repository.

The folder tree always contains a root folder, which by default is given the name $ and can-

not be deleted, destroyed or renamed. Subfolders of the $ root folder may be created,

renamed, deleted, and destroyed. When a folder is selected, the contents of the folder ap-

pear in the right pane of the main window, known as the file list. The file list displays files

added to the repository.

To add a file to the repository:

1. Do one of the following:

l On the File menu, click Add Files.

l Right-click an existing folder and then select Add Files from the shortcut
menu.

l Click the Add Files toolbar button.

The Add Files to Repository and Select Files to Add dialog boxes are displayed.
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2. In the Select Files to Add dialog box, browse to the files located on your computer
that you wish to add to the FTVersionTrak repository. Press and hold down the
CTRL key to select more than one file. Click OPEN when finished. After clicking
OPEN, the following will occur:

l The Select Files to Add dialog box is closed.

l The files you selected will appear in the Add Files to Repository dialog
box, under Files.

3. To continue browsing for files, click Browse in the Add Files to Repository dialog
box.

4. If you want, type a comment in the Comment box. The comment will be applied
to all of the files listed under Files.

5. Click OK to add the files listed under Files with the comment displayed under
Comment to the repository.

6. Click Cancel to close the Add Files to Repository dialog box without adding files
to the repository.
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